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The Outlook 2010 Screen 

 

Navigation Pane 

Mail Contains mail related folders like inbox and sent items folder.  Use the 
Favorites section at the top of the pane for easy access to frequently used 
folders. 

Calendar Allows you to view and schedule appoints, events and meetings, and 
compare calendars side by side. 

Tasks Organize to-do lists, track task progress and delegate tasks. 

Contacts Store addresses, phone numbers, and e-mail addresses. 
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E-mail Basics 

E-mail Basics:  View Tab 

Changing view of Reading Pane 

You can change the view of your Reading Pane on the screen, moving it to the right or bottom 
of the screen.  You can also turn it on an off. 

1. Click the View Tab. 
 

 

2. Click Reading Pane in the Layout section of the Ribbon. 
3. Click Right, Bottom or Off. 
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Changing View of Navigation Pane 

You can change the view of your Navigation Pane two ways as well – Normal or 
Minimized.  You can also turn the Navigation Pane off. 

1. Click the View Tab. 

2. Click Navigation Pane in the lay out section of the Ribbon. 

3. Click Normal, Minimized or Off. 
4. You can also choose whether you want the favorites folders to show. 

 

 

 

Changing View of To-Do Bar 

The To-Do Bar provides a Date Navigator, Appointments and Task List.  You can select which 
features of the To-Do Bar are visible and choose between Normal and Minimized views.  You 
can also turn the To-Do Bar off. 

1. Click View Tab. 

2. Click To-Do Bar in the Layout section of the Ribbon. 

3. Click Normal, Minimized or Off. 
4. Click Date Navigator, Appointments or Task List to toggle their visibility. 
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E-mail Basics:  Creating E-mails 

Sending an E-mail 

1. Click the Home Tab if necessary. 

2. Click New E-mail in the New section of the Ribbon.  The new e-mail window will 
open. 

 

 

 

3. Type the address of the recipient in the To... field. 

4. Type an address in the Cc… field if you wish to send a copy of the message to a 
third party. 

5. Type a subject matter in the Subject field. 

6. Type your message in the large text box. 

7. Click Send. 
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Auto-complete and the Global Address List 

Outlook has an auto-complete feature that attempts to predict what e-mail address you’re typing 
based on the addresses you’ve e-mailed in the past. 

1. Auto-complete appears as soon as you start typing an address in the To… field. 

2. The e-mail displayed will be Outlook’s best guess at what address you are 
typing.  It will refine as  you input more characters. 

3. Hit enter on your keyboard when the correct address is displayed and auto-
complete will fill in the remaining characters. 
 
 

 

The Global Address List is a statewide-wide contact list of state employees.  It can help you find 
contact information and e-mail addresses, and can be accessed from the new e-mail 
window.  We will discuss the Global Address List in greater detail later in this guide. 

1. Type an identifying piece of information, such as a last name, into the To… 
field.  You do not need to enter a full name, for example entering “Jorg” will bring 
up “Jorgensen” and “Jorgenson”. 

2. On your keyboard, hold the Ctrl key down and hit the K key. 

3. The Check Names window will open.  This window lists all matches from both 
your personal contacts and the Global Address List. 

4. Click the record for the person you want to message. 

5. Click OK. 

6. An e-mail address for the person you want to message will appear in the To… 
field. 
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Working with Folders 

Folders provide a useful way to manage your messages.  They appear in the navigation 
pane.  You can create folders in any structure that suits your needs. 

1. Right click on the folder that will house your new folder. 

2. Click New Folder in the drop down menu.  The Create New Folder window will 
open. 
 

 
3. Type the name of your new folder in the Name field. 

4. Click in the Select where to place this folder field if you wish to change where 
your folder will be located. 

5. Click OK. 
 

 



Outlook 2010 Basic Training                                                                                                                        Page 8 of 21 
 

6. The new folder will appear in the location you indicated. 
 

 

7. You can drag and drop messages directly to this or any folder. 

E-mail Basics:  Signatures 

Creating a Signature 
Outlook 2010 allows you to create custom signatures for your messages.  You may create 
multiple signatures to apply to messages as you see fit.  Your first signature is automatically 
applied as your default signature and will appear on your outgoing messages. 

1. Click the Home Tab if necessary. 

2. Click New E-mail in the New section of the Ribbon.  The new e-mail window will 
open. 

3. Click Signature in the New E-Mail menu. 

4. Click Signatures… in the drop down menu.  The Signatures and Stationary 
window will open. 
 

 
5. Click New to create a new signature. 
6. Type the name of your signature in the New Signature window that appears. 
7. Click OK. 
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8. Type your desired signature in the text box below. 

9. Click Save to save your signature. 

10.  Add additional signatures or Click OK to exit. 
 

 
 

Inserting a Signature 

If you have created more than one signature, you can select which one you wish to use while 
composing a new message. 

1. Open the New E-Mail window. 

2. Click Signature in the New E-Mail ribbon.  A list of the signatures you have 
created will appear in the drop down menu. 

3. Click on the signature you wish to use. 

4. The signature will appear in at the bottom of your message. 
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E-mail Basics:  Rules 

1. Click on Rules in the Ribbon. 

2. Click Manage Rules & Alerts in the drop down menu. 
 

 
3. Click New Rule.  This opens the Rules Wizard window. 

 

 

4. Select the type of rule you wish to create in the Step 1: Select a template menu. 

5. In this example, select Move messages from someone to a folder and Click Next. 
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6. Click the check box next to the condition(s) you wish to trigger the rule.  In this example, 
click from people or public group. 
 

 

 

7. Click the people or public group link in Step 2: Edit the rule description to open the 
Global Address List and select a person or group to whom the rule applies. 
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8. Click the specified link in Step 2: Edit the rule description to open a list of your 
folders.  Select the folder to which you want to move incoming messages and click OK. 
 

 

9. Your selections will appear in the Step 2 window.  Verify that they are correct and Click 
Next. 
 

 

10. Click what action you want Outlook to take with the messages.  In this case, click move 
it to the specified folder and click Next. 
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11. Select any exceptions you wish to apply to the rule.  In this example we are not adding 
any exceptions.  Click Next. 
 

 

12. Click Run this rule now on messages already in “Inbox” to have Outlook apply the 
filter to messages already in your inbox. 

13. Click Finish to complete the wizard and apply your new rule. 
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Calendar Basics 

Outlook 2010 has a robust calendar feature for managing your time and scheduling meetings 
with other STATE users. 

Access the Outlook Calendar 

1. Click on Calendar in the Navigation Pane.  The calendar will appear in the Outlook 
Screen. 
 
 

 

Adding an Appointment 

There are two ways to add an appointment to your calendar: 

1. Click New Appointment in the Ribbon. 
 

 
 
OR 
Double click an area on your calendar. 
 

 
2. The Appointment window will open. 
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3. Type a subject for your appointment in the Subject field. 
 

4. Type a location for your appointment in the Location field. 

5. Set a start and end date and time for your appointment. 

6. Type a note for your appointment in the large text box. 

7. Click in the Reminder field in the ribbon to set a reminder for your 
appointment.  Reminders can be scheduled for five minutes to two weeks before the 
appointment. 
 

 
8. Click Save & Close in the ribbon.  Your appointment will appear in your calendar. 
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Adding a Meeting Request 

Meetings differ from appointments in that a meeting allows you to invite attendees and reserve 
rooms and resources at Northwestern.  When you create a meeting request, invited users will 
receive an e-mail invitation to which they can respond.  You will receive notification when users 
accept, decline or propose a new time for the meeting.  There are two ways to access the New 
Meeting window. 

Invite users to the meeting by following the same steps as adding addresses to a mail message; 
auto-complete attempts to predict what e-mail address you’re typing based on the addresses 
you’ve e-mailed in the past, while The Global Address List provides a statewide contact list of 
STATE employees 

1. In the Mail view, Click on New Items in the Ribbon. 

2. Click Meeting in the drop down menu. 
 

 
 
OR 
In the Calendar view, Click New Meeting in the Ribbon. 
 

 
 
The New Meeting window will open.  

3. Type a subject for your meeting in the Subject field. 

4. Type a location for your meeting in the Location field. 
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5. Type a note about your meeting in the large text box. 
 

 

6. Click in the To… text box and begin typing the name or address of an attendee.  Auto-
complete will suggest a recipient.  Hit Enter on the keyboard to accept a suggestion. 
 

 

7. Type the name of an attendee in the To… field.  Hit Ctrl-K on your keyboard and select 
the attendee you want from the list that appears.  Click OK. 
 

 

8. Selected attendees will appear in the To… field. 

9. Select a date and time for the meeting. 

10. Click Send to send the invitation.  Attendees receive an e-mail invitation to the meeting, 
and you will be notified if they accept or decline. 
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Contact Basics 

Global Address List vs Personal Address Book (Contacts) 

You have two main ways of getting access to and storing contacts. You have access to a Global 
Address List that contains everyone in the State and a Personal Address Book for contacts 
inside or outside the State.  To access the Global Address List: 

1. Click Address Book on the right side of Ribbon.  The Address Book window will open. 

2. Click the More columns radio button.  Selecting this option will allow you to search by 
first or last name, or email address.  Once you have selected this option, Outlook will 
remember the selection, and you will not have to choose this option again. 

3. Type a name into the search box.  As you type, the search function will display possible 
matches. 
 

 
4. Click the name of the person for whom you are looking.  A new window will pop up with 

this persons’ contact information. 

5. Click Add to Contacts to add them to your personal address book.  A new window will 
pop up. 
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Click Save and Close.  They will appear in your Personal Address Book. 
 
 

 

 

 

To Access your Personal Address Book (Contacts): 

1. Click Contacts in the Navigation Pane.  Your contact list will open on the Outlook 
screen. 
 

 

2. You can add new contacts, add contact groups, delete contacts, e-mail contacts and 
invite contacts to meetings from this screen. 
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Tasks Basics 

The tasks function of Microsoft Outlook is a way to keep track of daily, weekly, monthly and 
even yearly “to do” items. You can use tasks to help remind you of once-in-a-while tasks that 
you must get done, or recurring tasks that happen all the time. 

Creating Tasks 

1. Click New Items in the Ribbon. 

2. Click Task in the drop down menu.  
 

 
3. The New Task window will open.  In this window you can:  

o Enter a subject for the Task. 
o Enter a start and end date. 
o Enter a status. 
o Assign a priority level. 
o Add a reminder. 
o Set the recurrence of the 

Task. 

o Set a follow-up reminder. 
o Assign the task to someone 

else. 
o Categorize the task. 
o Type notes for the task. 

 

4. When you are done filling in the New Task window, Click Save and Close. 
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Viewing Tasks/To-Do List 
 
Your new task is now visible in two places: 

1. The To-Do bar lists Tasks on the right side of the outlook screen. 

2. Double click a Task in the To-Do bar view and edit the Task. 
 
 

 

OR 

1. Click Tasks in the Navigation Pane.  This will open the Tasks view of the Outlook 
screen. 
 

 

2. You can view the details of a Task in the Reading Pane. 
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